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The principles of CCTV design in VideoCAD 
 

Part V   Video surveillance of moving objects 

 
Edition for VideoCAD 7 Professional                                                                                                  S. Utochkin 

 
In previous articles of this learning cycle, we have considered video surveillance of static objects only. But in 
reality, many of targets which interest us are moving objects that causes additional distortion of their images. 
Distortion of moving objects can make impossible, for example, recognition of a running person and reading 
license plate of a moving car, although standing person can be identified and license plate of standing car 
can be read. Because of the persistence of human vision, such distortion is less noticeable when watching 
video with high frame rate, but become apparent when viewing individual stop-frames. 
Distortions of moving objects are difficult to predict without using special modeling tools. Most of camera 
parameters are measured without taking into account motion. As a result, in most cases, the distortions of 
moving objects are ignored by CCTV designers. 
Neglect of motion of surveillance targets is one of the reasons of mismatch in image quality installed CCTV 
systems to specified requirements. 
In proper CCTV project object's motion and possible distortion of their images should be taken into account. 
VideoCAD version 7 provides special tools for this purpose. 
 
In this article we consider the main reasons of the distortion of images of moving objects, and tools for 
modeling these distortions. The article may be useful not only for VideoCAD users, but also for a wide circle 
of specialists. The information in the article is applicable for both analog and IP video surveillance. 
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The reasons of distortion of moving object images 

 
Images of moving objects in video surveillance are subject to both the same distortions as images of static 
objects (due to limited resolution, limited range of brightness, sharpening, compression, etc.) and additional 
specific distortions. 
These distortions depend on velocity 
of the objects, parameters and 
configuration of equipment, scene 
illumination, camera position and 
features.  
In case of the camera itself is being 
moved or vibrated, then these 
additional distortions have effect to 
the whole scene. 

 

 

The main reasons of additional distortion of moving objects images are: 
 

• Interframe compression; 
• Finite exposure time; 
• Rolling shutter; 
• Interlacing; 
• Finite frame rate. 

 
On real frames distortion caused by different factors are summarized, resulting in a significant loss of 
resolution of the object’s image. 
 
Let's consider the reasons of distortion in more detail.  
 

Interframe compression 

 
Compression algorithms, which uses one or more earlier or later frames in a sequence to compress the 
current frame (MPEG, H264, etc.) can significantly increase compression ratio, saving disk space and 
reducing the cost of data transmission channels. However, when using such algorithms moving objects can 
be recorded with distortions. Type and degree of these distortions depend on many factors, including 
features of compression algorithm and its settings, computing power of processor, the rate of recording 
frames, amount of changes of the whole image between frames. 
 
This kind of distortion becomes the most pronounced in the cases of high compression ratio of video, for 
example, when transmitting video via channels with insufficient bandwidth, at times of significant changes 
between frames and when using equipment with low computing power.    
 
It is impossible to accurately predict or simulate these distortions without going into detail of each 
compression algorithm, but in practice you can sometimes change their intensity by changing compression 
settings. 
 
When using intraframe compression which process each frame separately (MJPEG) this kind of distortion 
does not occur. Thus, if it is possible to use intraframe compression, we can eliminate this type of distortion. 
However, in this case, you must have reserve of bandwidth and storage capacity because of intraframe 
compression algorithms compress video stream much weaker for the same image quality of static objects.  
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Finite exposure time  

 
The motion blur is the main source of distortion of 
moving objects, which is shown up with varying 
intensity in many cases. Video sensor collects light 
in a finite period of time - exposure time (shutter 
speed). If an object has been moved on the screen 
during this time over a distance of more than half of 
pixel - object's blur becomes noticeable. 
The greater the exposure time is and the more 
velocity of the object on the screen, the more it 
becomes blurred. 

 

 

 Fig 1. Motion blur because of finite exposure time. 

 
The most of CCTV cameras have Automatic Electronic Shutter Control (AESC) which selects the exposure 
time automatically depending on lighting conditions. The worse the light is, the greater the exposure time is 
set. Thus, the worse the lighting, the greater is the blur of moving objects. 
On the other hand, the more sensitive a camera is and the more light passes camera’s lens (smaller F 
number of the lens), the less exposure time is required to obtain images with the same signal/noise ratio at 
the same light condition, the less is blur of moving objects. 
 
When using a lens with Auto iris, only the lens iris is adjusted according to the illumination, but the exposure 
time, as a rule, remains long regardless of the illumination. Long exposure time even in good light, leads to 
more blur of moving objects than when using lenses with fixed iris. 
 
To minimize the blurring you should use good lighting, fast lenses (with maximum aperture, minimum F-
number) and high sensitive cameras with the possibility of limiting exposure time.  
 
When reducing light, starting from a certain threshold illumination, the AESC of camera sets the 
maximum exposure time. When further reducing of light the exposure time is not increased anymore. 
Knowledge of the maximum exposure time and the threshold illumination of cameras are very useful 
when designing video surveillance systems. 
 
The maximum exposure time of standard analog cameras without light accumulation is 20 microseconds 
(ms) for PAL system and 16.5 ms for NTSC. IP cameras and analog cameras with accumulation of light 
can use the exposure time up to 200ms and more. With latent increasing the maximum exposure time, 
many manufacturers increase the certified sensitivity of their cameras. 
Because of the long maximum exposure time, the blur of moving objects is especially topical for IP cameras 
in low light conditions. 
 
Many modern cameras allow to change the maximum exposure time, switching between "night", "high 
sensitive" modes (long maximum exposure time - high sensitivity, but strong motion blur at low illumination) 
and "fast" "high speed" modes for surveillance of motion (maximum exposure time is short - noised image, 
but small motion blur at low illumination). 
If a camera has several modes of exposure time, for their proper use it is helpful to know the maximum 
exposure time for each of them. 
 
When the exposure time and the object’s velocity are known, the object’s blur on the image can be 
accurately modeled. VideoCAD offers special tools for this. 
 
In case the maximum exposure time is not given in the camera specification, VideoCAD offers a technique 
for measuring the exposure time. See the Help system: Examples of work with VideoCAD> Example 27 
Measuring exposure time of IP camera. 

http://www.cctvcad.com/videocad_help/index.html?mes_exposure.htm
http://www.cctvcad.com/videocad_help/index.html?mes_exposure.htm
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Rolling shutter 

 
Distortion from rolling shutter is not critical in the 
most practical cases, but sometimes it must be 
taken into consideration.  
 
Rolling shutter is often used in IP cameras with 
CMOS video sensors and never used in cameras 
with CCD video sensors. 
This technology allows manufacturers to increase 
the sensitivity of CMOS video sensor. 
 
As a result of the rolling shutter effect, the exposure 
of different rows of pixels on the sensor is 
performed with a time-shift, which causes a 
horizontal skew of moving objects. Distortion of 
objects with complex movement trajectories may 
be more complex. 

 

 Fig 2. Distortion from rolling shutter. 

 
This kind of distortion becomes the most pronounced on images from megapixel cameras with many rows of 
pixels. 
 
The opposite of the rolling shutter is the global shutter with which the entire frame is exposed for the same 
time window. 
 
The angle of the horizontal skew of a moving object on the image depends on horizontal component of 
velocity of the object’s image on the screen. If the velocity is constant, the skew angle is constant too. It 
depends on features of sensor used in the camera. 
 
The skew angle usually doesn't depend on lighting and the exposure time. If you change size of the image 
(number of rows of the image) in camera settings, the skew angle may remain the same or change based on 
sensor's features. 
 
It should be noted that cameras with rolling shutter have the same blur of moving objects because of finite 
exposure time as cameras with global shutter. The skew from rolling shutter is appeared in addition. 
When illumination is sufficient, camera automatic sets short exposure time, therefore the skew from rolling 
shutter becomes more prominent. If there is insufficient light, exposure time increases, and the motion blur 
masks the rolling shutter skew. 
 
An important parameter of rolling shutter is an interval of time between starts of exposure of neighboring 
rows. Let's call this parameter - the row time. This parameter is determined by camera sensor properties. In 
modern CMOS sensors it is within the limits of 20 - 100 microseconds. 
It is easy to calculate, for example, if video sensor has 1536 rows (3MP resolution - 2048x1536) and row 
time = 50 microseconds, the time difference between the exposure of the top and bottom rows will be 50 * 
1536 = 76.8 ms = 76800 microseconds. 
 
Unfortunately, the row time is not given in the camera's specification. Therefore VideoCAD offers a 
technique for measuring the row time. See the Help system: Examples of work with VideoCAD> Example 28 
Example 28 Measuring rolling shutter row time of IP camera. 

 
If the row time and object’s velocity in the frame are known, object's skew on the image can be accurately 
modeled. VideoCAD offers for this special tool. 

http://www.cctvcad.com/videocad_help/index.html?mes_rollingshutter.htm
http://www.cctvcad.com/videocad_help/index.html?mes_rollingshutter.htm
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Interlacing 
 
Distortions of moving objects caused by interlacing 
(combing) are familiar to specialists in video 
surveillance from the time when video signal from 
interlaced cameras was displayed on a computer 
monitor. 
 

 

 Fig 3. Distortion from interlace scan (combing). 

 
The combing effect appears when an image from a camera with interlaced scan is being shown on a display 
with progressive scan. 
In the cameras with interlaced scan the full frame is composed of two fields, line via line. These fields are 
exposed sequentially, at different times. And when this composite frame is being shown on a digital display, 
a time shift of moving objects on different fields becomes visible. 
Analog monitors (CRT) have the interlaced scan too, two fields on analog monitors are displayed 
sequentially as exposed, and therefore on an analog monitor the combing effect is absent. 
 
All analog cameras PAL and NTSC have the interlaced scan. All digital monitors have are progressive scan. 
Recording images to a file in computer memory is performed with progressive scan too. Therefore, the 
combing is manifested in almost all cases of use of analog cameras. 
 
The time period between exposures of neighboring fields in the PAL system is 20ms. (50 fields per second, 
25 full frames per second). In the NTSC system the period is 16.5ms. (60 fields per second, 30 full frames 
per second). 
If an object moved on the screen during this time over the distance more than half of pixel - the combing 
effect becomes noticeable.  
 
To combat the combing effect, video recording by individual fields is used, without combining fields into 
frames, which leads to loss of vertical resolution by 2 times. 
Special image processing - deinterlacing is also used, which makes the combing less noticeable, but it 
reduce vertical resolution of moving objects. 
 
If the time period between two fields in one frame and object's velocity on the screen are known, the 
combing effect can be accurately modeled. VideoCAD offers special tools for this. 
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Finite frame rate 

 
The finite frame rate restricts possibilities of surveillance of moving objects, although in general, it does not 
affect the image of the objects on individual frames. 
 
Obviously, the actual monitoring is being carried out only at moments of recording frames. During the time 
between frame shots surveillance is not made. 
If object's speed is sufficient for crossing the camera’s view area during the time between frame shots, then 
this object can be lost. 
 
When choosing the frame rate you must take into account the possible velocities of objects and the possible 
ways of crossing the view area so that the objects would not be lost. To slow objects additional obstacles 
(fences, turnstiles etc..) can be used. 
If you want detailed image of an object, the number of frames in which the object must get, should be 
increased, which increases the probability of getting the object at favorable angle. 
 
If trajectory and velocities of an object are known, as well as camera frame rate, it is possible to simulate a 
video in which we can estimate the number of hits of the object into the frame. 
You can also display the object's path during the period of time between frame shots as a vector and visually 
estimate the number of hits into frame on the 2D layout. 
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Work with VideoCAD 

 
VideoCAD 7 Professional version has tools for accurately modeling the distortions of moving objects caused 
by the exposure time, rolling shutter, interlaced scan, and tools for choosing the minimum frame rate based 
on the velocities of the moving targets. It can also generate animations with moving objects, and animated 
monitors with images from different cameras with different frame rates. 
 
Simulations of distortion of moving objects and animated images are resource intensive operations that 
require time and computer resources. In normal use it is not recommended to leave these functions enabled. 
 
Let's consider several examples of working with moving targets. 
 

Placing cameras, constructions and 3D models 

 
First, you must create a project, place cameras, set the basic parameters of cameras and lenses, place 
constructions, fixed and moving 3D models. 
Order of work is described in detail in the first and third articles of this cycle, Camera view area and 3D 
modeling in VideoCAD. 
Usual 3D models are used as moving objects. 
 

Specifying velocity vectors for moving objects 

 
For the 3D models used to simulate the moving objects, you must specify velocity vectors. In VideoCAD 7 
you can specify a velocity vector for any 3D model, thus turning it into a moving 3D model. 
 
Switch the 3D model into editing state by double clicking on its projections in the Graphics window. 
In the Speed box on the appeared Current construction parameter panel (at the bottom of the Graphics 
window), enter any nonzero velocity of the object in meters (feet) per second. 
 

 
 
On the projection of the 3D model the velocity vector (crimson arrow) will appear. 
 
You can edit the velocity vector of the 3D model in 
editing state by moving its terminus.  

  

Bring the cursor to the terminus of the velocity vector, 
click the left mouse button and drag the terminus. At 
the same time the speed value and direction of 
movement is being edited simultaneously. Click for 
the second time to specify new velocity and finish 
editing. 

 

 

 
Fig 4. Velocity vector of moving 3D model. 

http://www.cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part1.pdf
http://www.cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part3.pdf
http://www.cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part3.pdf
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If 3D model is selected then length of the velocity 

vector equals to the distance in meters (feet) 
which the 3D model passes per second (crimson 
arrow). 
If 3D model is in the normal state (non-selected), 

the length of the velocity vector equals to the 

distance which the 3D model passes for the 
period between successive frames of the active 
camera (black arrow). 

  
Fig 5. Velocity vectors of selected and non-selected 
3D models. 

 

Simulation of distortion of moving objects from exposure time, interlacing 
and rolling shutter 

 
For cameras which need to simulate distortion of moving objects you should set parameters that affect these 
distortions: 

 Exposure time; 

 Row time of rolling shutter for cameras with rolling shutter; 

 Time between fields in one frame for interlaced cameras. 
 
It is not necessary to set all parameters. For example, if you want to simulate only motion blur from exposure 
time, it is sufficient to set only the exposure time. 
VideoCAD can simulate all types of distortions on one image, but the simulation of each type of distortion 
increases the time of creating 3D image in several times. 
 
For proper modeling you must also correctly set the basic camera parameters: Sensor format, Lens focal 
length and Number of pixel on the sensor. 
  
In case the exposure time or the row time of rolling shutter is unknown, VideoCAD offers techniques for 
measuring these parameters. 
 

Let's consider an example. There are three cameras: 
 

 Three-megapixel (3MP) (2048x1536) IP camera with CMOS sensor and rolling shutter; 

 1.3 megapixel (1280x960) IP camera with CCD sensor and global shutter; 

 0.4MP (768x576) analog camera with interlace scan. 
 
We know camera exposure time at the scene light conditions: 
 

 3MP IP Camera - 100ms; 

 1.2MP IP camera - 50ms; 

 Analog camera - 20ms (PAL). 
 
3MP camera uses the rolling shutter, the period between reading successive rows (row time) = 50 
microseconds. 
 
All cameras have the same sensor size 1/3"and a lens with focal length = 4mm. 

http://www.cctvcad.com/videocad_help/index.html?mes_exposure.htm
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We know the camera position, location and velocity of 
moving objects on the scene. 
 
On the scene there is a car moving at speed of 20 m/s 
(72 km/h) and a woman running with speed of 2 m/s 
(7,2 km/h)/ 

 
We need to get models of images of the moving objects 
from each camera at the same position and compare 
these images. 
 

 

Fig 6. A car and a woman on the horizontal 
projection of view area in the Graphics window 

 
First, place camera, place 3D models and assign velocity vectors for the 3D models (see above). 
 

Modeling image from three-megapixel (3MP) IP camera 

 
Activate the camera by double clicking on its lens or by choosing its name in the Active camera combo box 
on the Toolbar.  

Open the  Camera Geometry   box and 
specify: 

 Image sensor format - 1/3"; 

 Lens focal length - 4mm; 

 Aspect ratio - 4:3.  
 
Then close the box. 
 
 

 
Fig 7 Basic camera parameters in the Camera Geometry box. 

 

Open the Sensitivity and resolution   box 
and specify numbers of pixels horizontal - 2048 
, vertical - 1536.  
 
 
Close the box and save changes. 

 

 

 
Fig 8. Specifying number of pixel in the Sensitivity and 
Resolution box. 
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Open the 3D window  . Stretch the 3D window for better resolution if needed.  
  

If the PiP mode is enabled (by default) in the 3D window a yellow rectangle will be displayed. And in the 
corner of the 3D window, inside a green rectangle, an image fragment from the yellow rectangle will be 
displayed (Fig.9). 
Pay attention that the entire frame is shown with a resolution lower than specified 2048x1536 and only the 
fragment from the yellow rectangle is shown with the actual resolution - 2048x1536. 
  

Place the yellow rectangle on the moving 3D model, by clicking the middle mouse button (wheel).  
 
For detail about PiP, see. Help system>Interface>3D window>Image parameter panel>PiP. 

  
By right clicking on the 3D window, open the Image parameter 
panel.  
 
Choose the Camera tab.  
 
 
Uncheck the According to the camera parameters box if it is 
checked.  
 
 
 
 
 
 
 
 
 
Choose '100' in the Exposure (ms) combo box.  
 
 
Check Model perm. on the Exposure (ms) panel. 
 
 
 
Choose '50' in the Rolling shutter combo box.  
 
 
Check Model perm. on the Rolling shutter panel. 
  

 

 
 

http://www.cctvcad.com/videocad_help/index.html?pip.htm
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During the image generation in the 3D 

window, on the 3D window  button 

red frame flashes . 
 
Simultaneous modeling exposure and 
rolling shutter can take several 
minutes.  
 
After a while you will see the image 
model (Fig.9).  
  
 

Save the image in the 3D window: 3D 
window>Main menu>Save as *.png 

 

 
Fig 9. Image model from 3MP IP camera. 

 
You can adjust realism of modeling exposure and rolling shutter on the 3D tab of the Options box. The 
more realistic simulation is, the more time required to generate the images in the 3D window. 
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Modeling image from 1.3MP IP camera 

  

Open the Sensitivity and resolution   box 
and specify numbers of pixels horizontal - 
1280, vertical - 960.  
 
 
Close the box and save changes. 

 

 

 
Fig 10. Specifying number of pixel in the Sensitivity and 
Resolution box. 

 

 

 

Open the 3D window  . By right clicking on the 3D window, open 
the Image parameter panel.  
 
Choose the Camera tab.  
 
 
Uncheck the According to the camera parameters box if it is 
checked.  
 
 
 
 
 
 
 
 
 
Choose '50' in the Exposure (ms) combo box.  
 
 
Check Model perm. on the Exposure (ms) panel. 
 
 
 
  
 
 
Clear Model perm. on the Rolling shutter panel. 
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After a while you will see the image 
model (Fig.11).  
  
 

Save the image in the 3D window: 3D 
window>Main menu>Save as *.png 

 

 

Fig 11. Image model from 1.3MP IP camera. 
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Modeling image from 0.4MP analog camera 

  

Open the Sensitivity and resolution   box 
and specify numbers of pixels horizontal - 768, 
vertical - 576.  
 
 
Close the box and save changes. 

 

 

 
Fig 12. Specifying number of pixel in the Sensitivity and 
Resolution box. 

 

 

 

Open the 3D window  . By right clicking on the 3D window, open 
the Image parameter panel.  
 
Choose the Camera tab.  
 
 
Uncheck the According to the camera parameters box if it is 
checked.  
 
 
 
 
 
Choose '20' in the Interlace combo box. 
Check Model on the Interlace panel. 
 
 
Choose '20' in the Exposure (ms) combo box.  
 
 
Check Model perm. on the Exposure (ms) panel. 
 
 
 
 
 
 
Clear Model perm. on the Rolling shutter panel. 
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After a while you will see the image model (Fig.13).  
  
 

Save the image in the 3D window: 3D 
window>Main menu>Save as *.png 

 

 
Fig 13. Image model from 0.4MP analog camera.. 

 
Compare images from different cameras (Fig. 9, Fig 11, and Fig.13). You can see that resolution of moving 
objects depends of camera’s exposure time more than of camera’s number of pixels. 
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Choosing optimal frame rate 

 
The frame rate greatly affects the required bandwidth of communication channels, capacity of the video 
archives, computing power, and hence the total cost of video surveillance systems. 
 
At the same time, choosing optimal frame rate is not an easy task and criteria for selection are not always 
unambiguous. When the frame rate is too low, the losing important events is possible, too high frame rate 
leads to unjustified rise in price of the video surveillance systems. 
  

VideoCAD offers a tool for choosing frame rates based on the desired frequency of getting into the 
frame objects with known positions and velocities. Additionally, you can create animated images with 
the specified frame rate. 

 
Suppose we set the camera, set the location and speed of moving objects (3D models). We need to choose 
the minimum frame rate to get any object into the frame at least twice. 
 
Choosing the frame rate for the active camera is carried out visually by comparing the velocity vector of 
moving 3D model and the width of camera view area at the locations of the moving objects. 
The lengths of the velocity vectors of non-selected (in the normal state) 3D models show which distance is 
passed by the appropriate 3D model during the period of time between frames of the active camera. 

 
Remove selections from the 3D models if there are selected ones. 

  

Open the 3D window . By right clicking open the Image parameters 
panel. Chose Camera tab. 

  

 

 

 

 

 
Change Frame rate value, watching the velocity vectors of 3D models 
in the Graphics window.  

 

 

  
Select the Frame rate in order that all velocity 
vectors fit in the view area projection at least 
twice. 
 

 

 
Fig 14. The length of the velocity vector equals to the 
distance which the 3D model passes for the period 
between successive frames of the active camera. 
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Choose the View tab on the Image parameters panel.  

 
Uncheck the According to the camera parameters box if it is checked.  

 

 

 

 

 

 

 
Check Animation box. Set the Number of frames =3 or more. 

 
In several seconds animated image with specified frame rate will 
appear in the 3D window. In the image there will be 3D models with 
specified velocity. 
 

  

   
Fig 15. The frames of the animated image with specified frame rate. 
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Simulation of animated monitor 

 
VideoCAD 7 Professional allows to create animated models of monitor as *.html file. These models may 
contain up to 100 animated images from different cameras. Each image has its own settings (frame rate, 
resolution, etc.). Obtained html file can be viewed by any Internet browser, placed in the internet, edited 
with any text editor, etc. 
 
Clicking on any image on your monitor you can show the selected image with resolution of the appropriate 
camera. 
  

Adjusting animation of the cameras which should have animated images 

 
Activate one of those cameras, which should have animated images. 

Open the 3D window by clicking on the ЗD window   button on the Tool 
bar of the Graphics window. Right click on the 3D window to open the 
Image parameter panel. 
Choose the Camera tab.  
 
Uncheck the According to the camera parameters box if it is checked.  
 
 
 
Adjust the Frame rate. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select all cameras on the layout, which should have animated images.  
 
 
Check the To selected cameras box.  
 
 
Click on the Save button. 
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Switch to the View tab.  
 
 
 
 
 
Uncheck the According to the camera parameters box if it is checked.  
 
 
 
 
 
 
 
 
 
Check the Animation box.  
 
Set the Number of frames = 2 or more. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select all cameras on the layout, which should have animated images.  
 
Check the Save to selected cameras box.  
 
Click on the Save button. 

 

 
 

 

After several seconds in the 3D window the animated image will be shown. The image with the specified 
frame rate will contain moving with the specified velocities 3D models. 
 
We have set the same number of frames in the animated images and the frame rate for all selected 
cameras simultaneously. You can set individual values for each camera, not checking the To selected 
cameras box before clicking the Save button and repeat adjusting for each camera separately. 
  

To save animated image from the active camera on this step, click Main menu of 3D 
window>Image>Save as animated *.gif.  
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Connection of the cameras to the Monitor 

 

Open the Monitor window by clicking on the Monitor window   button on the Tool bar of the Graphics 
window. 
 

Click on the Edit  button on the Tool bar of the opened Monitor window. 
 
Select on the layout cameras which should be displayed on the Monitor.   
  

You can select cameras with static and animated images mixed. 
  

Then click on a cell of the Monitor starting from which these cameras should be displayed on the Monitor. 
  

After some time the 3D window will appear, in which static images from these cameras will be simulated. 
Then these images will appear in the cells of the Monitor, starting from the clicked cell.  
  

See more details of work with Monitor: Help system>Interface>Monitor window>Work with Monitors. 
 

Switching the Monitor window to the animation mode 

 

Click the Animation  button on the Tool bar of the Monitor window. 
  

The 3D window will appear again, but this time it will generate animated images for your monitor. 
  

Generation of animated images takes much longer, it is a complex multi-threaded resource-intensive 
operation. Be patient, do not touch the mouse and keyboard, do not interfere the program, otherwise errors 
are possible. 

 

Saving the animated Monitor to HTML file 

 
For this click on the Monitor window Main menu> Image> Export to *.html.  
  

It is recommended to save the *.html file to a separate directory. The resulting "file" includes the actual 
HTML file with links to images and the image files in animated GIF and PNG formats. The images are 
stored with the resolution and other parameters of the corresponding cameras. 
 

See an example of animated monitor (file size about 4 Mb).  
http://cctvcad.com/monitor/Monitor_1.html 
 
Back: 
 

Part I. Camera view area. 
Part II. Person detection area, person identification area, license plate reading area. Spatial resolution. 
Part III. 3D modeling in VideoCAD. 
Part IV. Illumination and camera sensitivity in CCTV. 
 
Continue: 
 

Part VI. Lens distortion in CCTV design  

 

http://www.cctvcad.com/videocad_help/index.html?workwithmonitor.htm
http://cctvcad.com/monitor/Monitor_1.html
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part1.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part2.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part3.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part4.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part6.pdf

